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Wellness Goodness

Monday, September 12, 2011 

PHOENIX (H&U) –

f an ounce of prevention is worth a pound of cure, is a
pound of prevention worth sixteen pounds of cure?
Well (no pun intended), there just might be some

geometric progression involved on top of the ratio; but
       

even if there isn't, a well-designed Wellness Program
can be a tremendous return on investment. Read on for
some solid ideas for your Wellness Program today.

Employer/Employee Benefits of a Wellness-Program Employee Benefit

We can't possibly list all of the potential and actual
benefits of a well-designed and comprehensive Wellness
Program, but just consider a few items.

Reduced absenteeism

Enhanced alertness

Lessened workplace stress

Lowered premiums

Decreased attrition hence pared employee-turnover
costs

Raised employee loyalty and satisfaction, etc.

Those are but a few, and they're common sensible.

One Stat.

Here's an interesting statistic. Health and Wellness
Institute says that lowering an overweight person's body
mass index by just one point corresponds to around $200
in healthcare-cost savings a year. If weight loss is
managed properly to avoid crash weight-lost that

         

promotes yo-yo dieting and if the weight can therefore be
kept off, consider all the benefits to the individual and
also the employer, not to mention the individual's family
that may be very negatively impacted by a breadwinner's
illness.

Tailor Together

Not everyone is going to need a weight-reduction
program. A comprehensive Wellness Program has to be
tailored to meet the differences within the given
workforce. There will be different existing fitness levels.
There will be old and existing injuries requiring
workarounds. Regardless of the variations in the program,
one thing experience has shown is that group participation

   

has a multiplying effect.

People encourage each other and can help monitor each
other's improvements. A team spirit can set in, which
raises morale and self-esteem and a sense of belonging
and worth within the group. This in itself has a positive
impact upon overall health, individually and group-wise.

Potential Activities

To get your group brainstorming, here are a few ideas for
a Program.

Yoga

Zumba

Tai chi

Smoking cessation (VERY IMPORTANT!)

Bicycling

Dancing

Low-impact aerobics

Weight training (properly supervised)

Stress management

Time management (Yes, it's health related.)

Financial management (major stress reducer)

Anger management
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Group walking

of course, Weight loss

Swimming

Health-club benefits

Disease management

Incentives/Rewards (more on this below)

Organizational intranet-resources concerning all of
the above and more

Checkup First

You've probably read or heard this next line many times,
but it's worth repeating. Before embarking upon an
exercise program, get a medical checkup. Have your
doctor clear you for specific levels of exercise. If you have
an unknown or known underlying health problem, certain
levels of exercise could trigger a health emergency. Don't
chance it.

If you're the employer, get a copy of that medical
       

clearance. Note any restrictions, and help everyone to
help the individual to stick to them. Also, note scheduled
return appointments and obtain any changed information
concerning exercise restrictions. 

It should go without saying, but take care to protect
health information and to avoid any illegal discriminatory
activities based upon health conditions.

Build In

The Wellness Program should be included in your
organizational manuals and whether those are digital or
hardcopy. Communications concerning the Wellness
Program should be included in organizational newsletters,
calendars, paycheck stuffers, and the like. Improvements
in health and the cost-savings attributable to those should

   

also be included. 

When people see improvements in writing and even see
themselves reflected in such, it's just another layer of
encouragement and sense of involvement.

Incentives/Rewards

You can be creative in terms of how you incentivize and
reward Wellness Program participation and advances.

Upon successful completion, give money, goods, or
services or simply reimburse the employee for
authorized wellness expenses

Withdraw the reward upon an employee
backsliding, such as taking up smoking again or

     

gaining back too much weight, etc.

Right now, the law allows rewards of up to 20 percent of
the cost of coverage. 

In 2014, provided the health-reform law (Patient
Protection and Affordable Care Act) hasn't changed by
then, it will increase to 30%. There is a provision for
increasing it to 50% where appropriate.

H.R.3590 

Patient Protection and Affordable Care Act (Enrolled Bill [Final as Passed Both House and
Senate] - ENR) 

`SEC. 2705. PROHIBITING DISCRIMINATION AGAINST INDIVIDUAL PARTICIPANTS AND
BENEFICIARIES BASED ON HEALTH STATUS.

(j) Programs of Health Promotion or Disease Prevention- 
`(1) GENERAL PROVISIONS- 
`(A) GENERAL RULE- For purposes of subsection
(b)(2)(B), a program of health promotion or disease
prevention (referred to in this subsection as a `wellness
program') shall be a program offered by an employer that
is designed to promote health or prevent disease that
meets the applicable requirements of this subsection. 
`(B) NO CONDITIONS BASED ON HEALTH STATUS
FACTOR- If none of the conditions for obtaining a
premium discount or rebate or other reward for
participation in a wellness program is based on an
individual satisfying a standard that is related to a health

cost of employee-only coverage under the plan. If, in
addition to employees or individuals, any class of
dependents (such as spouses or spouses and dependent
children) may participate fully in the wellness program,
such reward shall not exceed 30 percent of the cost of the
coverage in which an employee or individual and any
dependents are enrolled. For purposes of this paragraph,
the cost of coverage shall be determined based on the
total amount of employer and employee contributions for
the benefit package under which the employee is (or the
employee and any dependents are) receiving coverage. A
reward may be in the form of a discount or rebate of a
premium or contribution, a waiver of all or part of a cost-
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status factor, such wellness program shall not violate this
section if participation in the program is made available to
all similarly situated individuals and the requirements of
paragraph (2) are complied with. 
`(C) CONDITIONS BASED ON HEALTH STATUS FACTOR- If
any of the conditions for obtaining a premium discount or
rebate or other reward for participation in a wellness
program is based on an individual satisfying a standard
that is related to a health status factor, such wellness
program shall not violate this section if the requirements
of paragraph (3) are complied with. 
`(2) WELLNESS PROGRAMS NOT SUBJECT TO
REQUIREMENTS- If none of the conditions for obtaining a
premium discount or rebate or other reward under a
wellness program as described in paragraph (1)(B) are
based on an individual satisfying a standard that is related
to a health status factor (or if such a wellness program
does not provide such a reward), the wellness program
shall not violate this section if participation in the program
is made available to all similarly situated individuals. The
following programs shall not have to comply with the
requirements of paragraph (3) if participation in the
program is made available to all similarly situated
individuals: 
`(A) A program that reimburses all or part of the cost for
memberships in a fitness center. 
`(B) A diagnostic testing program that provides a reward
for participation and does not base any part of the reward
on outcomes. 
`(C) A program that encourages preventive care related
to a health condition through the waiver of the copayment
or deductible requirement under group health plan for the
costs of certain items or services related to a health
condition (such as prenatal care or well-baby visits). 
`(D) A program that reimburses individuals for the costs
of smoking cessation programs without regard to whether
the individual quits smoking. 
`(E) A program that provides a reward to individuals for
attending a periodic health education seminar. 
`(3) WELLNESS PROGRAMS SUBJECT TO REQUIREMENTS-
If any of the conditions for obtaining a premium discount,
rebate, or reward under a wellness program as described
in paragraph (1)(C) is based on an individual satisfying a
standard that is related to a health status factor, the
wellness program shall not violate this section if the
following requirements are complied with: 
`(A) The reward for the wellness program, together with
the reward for other wellness programs with respect to
the plan that requires satisfaction of a standard related to
a health status factor, shall not exceed 30 percent of the

        

sharing mechanism (such as deductibles, copayments, or
coinsurance), the absence of a surcharge, or the value of
a benefit that would otherwise not be provided under the
plan. The Secretaries of Labor, Health and Human
Services, and the Treasury may increase the reward
available under this subparagraph to up to 50 percent of
the cost of coverage if the Secretaries determine that such
an increase is appropriate. 
`(B) The wellness program shall be reasonably designed
to promote health or prevent disease. A program complies
with the preceding sentence if the program has a
reasonable chance of improving the health of, or
preventing disease in, participating individuals and it is
not overly burdensome, is not a subterfuge for
discriminating based on a health status factor, and is not
highly suspect in the method chosen to promote health or
prevent disease. 
`(C) The plan shall give individuals eligible for the
program the opportunity to qualify for the reward under
the program at least once each year. 
`(D) The full reward under the wellness program shall be
made available to all similarly situated individuals. For
such purpose, among other things: 
`(i) The reward is not available to all similarly situated
individuals for a period unless the wellness program
allows-- 
`(I) for a reasonable alternative standard (or waiver of
the otherwise applicable standard) for obtaining the
reward for any individual for whom, for that period, it is
unreasonably difficult due to a medical condition to satisfy
the otherwise applicable standard; and 
`(II) for a reasonable alternative standard (or waiver of
the otherwise applicable standard) for obtaining the
reward for any individual for whom, for that period, it is
medically inadvisable to attempt to satisfy the otherwise
applicable standard. 
`(ii) If reasonable under the circumstances, the plan or
issuer may seek verification, such as a statement from an
individual's physician, that a health status factor makes it
unreasonably difficult or medically inadvisable for the
individual to satisfy or attempt to satisfy the otherwise
applicable standard. 
`(E) The plan or issuer involved shall disclose in all plan
materials describing the terms of the wellness program
the availability of a reasonable alternative standard (or
the possibility of waiver of the otherwise applicable
standard) required under subparagraph (D). If plan
materials disclose that such a program is available,
without describing its terms, the disclosure under this
subparagraph shall not be required.

Wellness With Insurance

Obviously, there's a great deal to the law and the various
Wellness Programs that one my implement. Naturally,
all this ties in with Health Insurance. 

We all want, or should want, the healthiest environment
          

possible at the lowest cost and with the greatest level of
protection/risk transfer. Let Hill & Usher work with you in
your effort to attain the best mix and balance for your
organization and family. We offer the full complement of
Health-Insurance options. We're here to help.

Contact Us Right Now

Hints: 
In newer versions of Adobe Reader and Adobe Acrobat:

1. Save your work-in-progress: Menu > File > Save.

2. Menu > Edit > Preferences > Forms > Auto-Complete >
Basic: "The basic auto-complete feature stores the

larger list of possible matches."

3. Menu > Edit > Preferences > Forms > Auto-Complete >
Advanced: "The advanced auto-complete feature stores the
information you enter into form fields and uses these entries
to suggest relevant choices as you type into a field. If there
are probable matches for a field, tabbing into that field will
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information you enter into form fields and uses these entries
to suggest relevant choices as you type into a field. Once
you enter a character into a field, a drop-down box displays
a list of only the most probable matches. Double-click or
press Down Arrow in an empty field to display an even

    

automatically display a list of them. If there is a very
probable match, it will be entered in the field automatically.
Pressing Tab while the pointer is over an entry in the list
chooses the entry and moves to the next field."

Remarks

Date
Month  Day  Year (yyyy)

If you know your Hill & Usher
Account Number, please
enter it now. Other-wise,
skip to the next section.

Attached to Pre-existing First Named Insured (if any)

Full Legal Name

Primary Contact

Primary Contact data already
on file with Hill & Usher

 Yes  No

If "Yes" and if you've entered above 1) the applicable Hill & Usher Account Number or 2)
the full legal name of the Pre-existing First Named Insured, then skip the rest of this
Primary Contact section, enter any desired remarks, and submit the form. 

If you are unsure of any applicable Hill & Usher Account Number or whether there is a
Pre-existing First Named Insured, please fill out this Primary Contact section.

Type

 First Named Insured  Co-Insured  Other

 Not Selected

First Name

Middle Initial

Last Name
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Home Telephone 
(10 digits)

Cell 
(10 digits)

Business Telephone 
(10 digits)

Fax 
(10 digits)

Email

Preferred Method
for Contact  Home Phone  Cell  Business Phone  Email

 Not Selected

Contact at Work
 Contact at work anytime 

 Contact at work only for emergencies 

 Never attempt to contact at work under any circumstances

 Not Selected

Aerial Pak 
(Aerial Photographers)

Package Choice 
(Photography Studios)

Bar Pak 
(Restaurants & Bars)

Trim Risk 
(Landscapers)

In newer versions of Adobe Reader and Adobe Acrobat, save your completed form before submitting: 
Menu > File > Save.

If you have any computer/technical questions/problems with this form, please email our webmaster or call our office @ 800·956·4220 
- Monday through Friday, from 8AM to 5PM, Arizona time -

Hill & Usher Specialty Programs

Residential General-Contractors You may also access Hill & Usher Speciality Pro-
grams via the menu and sidebar on our main
homepage: HillUsher.com
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Like • Follow • Subscribe

                   

Hill & Usher Insurance & Surety, LLC. 
3033 North 44th Street 
Suite 300 
Phoenix, Arizona 85018

Email:sales@hillusher.com Phone: 800·956·4220 
Fax: 602·956·4418

Wellness-091211.pdf © 2011 Hill & Usher Insurance & Surety, LLC. 
All Rights Reserved.
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